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1. System and Software Configuration 

1.1. Supported System Configurations 
SAS Marketing Operations Management is supported on the following system configurations that may consist of 

one to four server machines. 

In a given configuration, one or more installer components need to be selected while installation on an individual 

server in the configuration. The installer components to be selected depend upon the tiers to be hosted on the 

server. 

The installation consists of five tiers: 

 Web Services Tier 

 Solutions Tier 

 Cataloger Tier 

 Media Processing Tier 

 Database Tier 

 

The installer has components that relate to the first four tiers. It is not required to run the installer for the 

Database tier. 

This document applies to following system configuration consisting of the following servers: 

 Web Server – The web server hosts the Solutions Tier. 

 Application Server – The application server hosts the Web Services Tier. 

 Cataloger Server – The cataloger server hosts the Cataloger Tier. 

 Media Processor – The media processor server hosts the Media Processor Tier. 

 Database Server – The database server hosts the Database Tier. 

1.2. Software Stacks 
Before installing SAS Marketing Operations Management version 6.0 R14 on the server’s, the following third party 

software’s need to be installed on the specified servers. The installers of the following software are available in the 

‘Folder D Prerequisite Software’ folder with the SAS Marketing Operations Management installer. The name of the 

exe’s is mentioned in the table below: 
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Windows 2008 R2 Server (64 Bit) 
(Should have EN-US as its locale) Y Y Y Y Y  Y Y Y 

Windows 7 (64 Bit)      Y    

IIS 7.0 (version 7.5.7600.16385) Y Y Y Y  Y Y Y Y 
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MSMQ Y Y Y Y  Y Y Y Y 

.NET Framework 3.5 Y Y Y Y  Y Y Y Y 

MSXML 4.0 Y Y Y Y      

Microsoft SQLXML 4.0 SP1 
(sqlxml.msi) 

Y         

Microsoft SQL Server System CLR 

Types 

(SQLSysClrTypes.msi) 
Y Y        

Shared Management Objects 

(SharedManagementObjects.msi) Y Y        

Access Database Engine x64 

(AccessDatabaseEngine_x64.exe) Y Y Y       

Microsoft WSE 3.0 
(Microsoft WSE 3.0.msi) 

Y Y Y Y  Y Y Y Y 

Microsoft SQL Server 2008 R2     Y     

Media Streaming Server    Y      

Acrobat 8.0/9.0/X Professional 
Edition  

Y  
(if 
WebDAV 
is being 
used) 

     Y  

Microsoft Visual C++ 2008 
Redistributable Package 
(vcredist_x64.exe) 

Y Y Y Y  Y Y Y Y 

Crystal Reports Basic for Visual 
Studio 2008 x64 Redistributable 
Package 
(CRRedist2008_x64.msi) 

Y Y        

Microsoft Office 2010 x64 bit        
 

Y 
 

Image Magick (ImageMagick-
6.7.3-4-Q16-windows-x64-
dll.exe) 

        Y 

ASP.NET State Service  Y        

Adobe Illustrator CS3/CS4 (Only 
if Artwork Producer is being 
deployed for the customer) 

     Y    

Adobe InDesign CS5.5 server 
(Only if Artwork Producer is 
being deployed for the customer) 

      Y   

 

Notes:  
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 MS Office can be installed on a separate server in the network or on any one of the other 

servers provided the servers are within the firewall 

 Ghostscript needs to be installed on the machine where Media Generator/Image Magick is installed. This 

is available in the ‘Folder D Prerequisite Software’ - 

http://ghostscript.com/releases/gs871w64.exe 

 Once all the above mentioned pre-requisites are installed, then add an additional search folder in the 

“Path‟ environment variable (system variable) on the machine where ImageMagick and GhostScript are 

installed. Add the following path: <Path of GhostScript>\bin. For example: C:\Program Files\gs\gs8.71\bin 

 The dialogs for online updates and software registration for Adobe Acrobat needs to be disabled after 

installing it. Please refer to Suppress Dialogs for Automatic Updates section for further details. 

 MSXML 4 is Microsoft provided XML parser 

 Fulfill the registration requirements for Adobe Illustrator CS3 and CS4 

 Install windows component ‘Messaging Queuing Service’ with HTTP support enabled 

 A server certificate is required in case HTTPS protocol is to be used to access SAS Marketing Operations 

Management application 

 QuickTime need to be installed on the Cataloger, Mediaserver and Webservice machines. (QuickTime 

setup needs to be downloaded online, it is a freeware). This needs to be installed only in case XMP 

information needs to be downloaded from video files. 

1.3. Port Communication 
Port 80 – This port needs to be opened on all SAS Marketing Operations Management related servers. The port 

information is as shown in the table below: 
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                             TCP: 16601 

 

 Application Services communicates with the 

Dashboard services using TCP on port number 

16601. This port is configurable 

 Dashboard Services is used to generate Dashboard 

contents for a user 

 Dashboard Service is a windows service 

 

                             

 

                             TCP: 16602 

 

 

 

 Media Server communicates with the Plugin Services 

using TCP on port number 16602. This port number 

is configurable 

 Plugin Services is used to generate various rendition 

of format and also for FTP, compression for DAM 

contents 

 Plugin Service is a windows service 

 This is used by Digital Library 

 

 

                            HTTP: 16603 

 Media Processor communicates with InDesign CS5.5 

server using HTTP on port number 16603. This port 

number is configurable 

 InDesign CS5.5 Server is used to generate artworks 

 This is used by Artwork Producer 

 

                              

                            TCP: 16605 

 

 

 

 Web Server or the application server communicates 

with the BusinessEvents server using TCP on port 

number 16605. This port number is configurable 

 BusinessEvents Server is used to track changes for 

Entities 

 BusinessEvents Service is a windows service 

 

 

1.4. End-User Machine Requirements 
The software required on the client/browser machine is: 

Browser machines –  

 Windows – Windows XP, Windows Vista, Win2K, Windows 2008, Windows 7 

 MAC – Snow Leopard 10.6.8 

 Browsers – Internet Explorer 8.0 and 9.0 (Compatibility mode) (Windows 32 bit), Firefox 12.0 

(Windows) and Safari 5.1.5 (Mac) 

 Acrobat Professional 8.0/9.0/9.3.2/X – For adding comments to PDF documents (in case WebDAV or 

Adobe Acrobat is used) 

 MS Office 2007/2010 – For opening office documents (Reports) and adding comments to Word and 

Excel documents during approval 

 Flash Player 10.3.183.11 – For viewing the dashboard analytical channels 

Application 

Services 

Dashboard 

Services 

Media 

Server 

Plugin 

Services 

Media 

Processor 

InDesign 

CS5.5 

Web or 

Application 

Services 

BusinessEvents

Server 
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2. Pre-requisites for System and Software Configuration 

2.1. For MOM Desktop 
MOMDesktop is an extended part of the SAS Marketing Operations Management solution, which is built on AIR 

platform from Adobe.  The MOMDesktop helps to catalog digital data in bulk/batch into the Digital Library and 

easily associate metadata/business information to it (which is not possible through the web based solution). 

File Sharing 

Connects to the Cataloger Sever to transfer files selected by user to catalog into the SAS Marketing Operations 

Management system. 

Connects to the Solution Server to validate user and retrieve Section hierarchy for the user. 

 

System Requirements 

Minimum 5MB free disk space. 

 

MOMDesktop deployed on the end user desktop machine requires connecting to the Web Server and the Cataloger 

machine. Both the machine's IP Address/ DNS name should be publicly visible on the internet. 

2.2. SQL Server Configuration 

2.2.1. Configure Memory Options 
The following are the steps to specify the ‘Use of AWE’ to allocate memory for SQL Server: 
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 Open Microsoft SQL Server Management Studio. 

 Connect to the database server by supplying the appropriate credentials. 

 Right click on the database server name and select Properties from the speed menu. 

 On the popup click on the ‘Memory’ option on the left pane. Memory specific settings will be displayed. 

 Select the ‘Use AWE to allocate memory’ option from the Server memory options group. 

 Click on the ‘Ok’ button to save the details.  

 

Figure No.1   

2.2.2. Setting up communication protocol 
Configure the following settings for SQL Server 2008 (reachable via Start | Programs | Microsoft SQL Server 2008 | 

Configuration Tools | SQL Server Configuration Manager): 

Expand the SQL Native Client Configuration and select the Client Protocols option 

Enable the following protocols: 

TCP/IP 

2.2.3. Set Query execution timeout 
The following are the steps to set query execution timeout for SQL Server to 0 (i.e. infinite): 
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 Open Microsoft SQL Server Management Studio 

 Connect to the database server by supplying credentials. 

 Navigate to Tools Menu | Options. This will open a dialog. 

 Expand Query Execution | SQL Server option from tree view. 

 Clicking on the SQL Server option, settings will be displayed. 

 These settings contain Execution time-out setting. Set the value for this setting to 0. Save the setting. 

Close instances of SQL Server Management Studio and restart SQL Server from Services panel. 

 

2.3. For WebDAV 

2.3.1. Installing and enabling WebDAV on Windows 2008 R2 and IIS 7 
Install WebDAV: 

Go to Start->Run and type: Server Manager. 

Click on the Server Manager node, which is in the left pane at the top of the tree view. 

On the right pane check if the WebDAV feature is installed in Web Server (IIS) Role. 

If not installed, then click the Add Role Service link and select the WebDAV Publishing Service. 

 

Figure No.2   
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Figure No.3   
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Figure No.4   
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Figure No.5   

 

2.3.2. Enable WebDAV 
Configure the following settings in the IIS Manager: 
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 Go to Start->Run and type: IIS Manager. 

 Select Default Web Site node in the tree view which is in the right pane. 

 Double click on WebDAV Authoring Rules icon in the middle. 

 

Figure No.6   
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 Click Enable WebDAV link in the Action Pane on the right. 

 

Figure No.7   
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 Add Authoring Rule for Default Web Site as shown in the figure below. 

 

Figure No.8   
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Figure No.9   

 

2.3.3. Installing Windows Authentication on Windows 2008 R2 and IIS 7 
Install Windows Authentication: 
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1. Go to Start->Run and type: Server Manager. 

2. Click on the Server Manager node, which is in the left pane at the top of the tree view. 

3. Now on the right pane check that the Windows Authentication feature is installed in Web Server (IIS) 

Role. 

4. If is not already installed, then click the Add Role Service link and select the Windows Authentication 

Service. 

 

Figure No.10   

 

2.3.4. Enabling Windows Authentication for ALDocShare Virtual Directory in IIS 7 
Configure the following settings in the IISManager: 
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1. Go to Start->Run and type: IIS Manager. 

2. Select ALDocShare virtual directory under Default Web Site node in the tree view which is in the right 

pane. 

3. Double click on Authentication icon in the middle. 

 

Figure No.11   

 

4. Enable Windows Authentication for ALDocShare virtual directory. 
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Figure No.12   

 

2.4. IIS Settings  
These settings need to be done before installation. Steps to be followed for Internet Information Service (IIS) 

Manager Configuration: 
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Navigate to the path Start | Administrative Tools | Internet Information Service (IIS) Manager. 

Navigate to the Application Pools and click on the ‘Set Application Pool Defaults’ link in the Actions menu. 

In Process Model section, edit the Identity setting. For Application Pool Identity select the Built-in account radio 

button. 

Save the configuration. 

 

Figure No.13   

Note: These settings need to be done only on the Web Services and Web Server machine in case of multi-machine 

installation. In case of one machine installation, it has to be done on the server where SAS Marketing Operations 

Management is installed. 

 

Navigate to the path Start | Administrative Tools | Internet Information Service (IIS) Manager. 

Navigate to the Application Pools and click on DefaultAppPool link. Click on Advanced Settings link in the 

actions menu. On the Advanced Settings popup, in the Process Model section, edit the Identity setting. Select 

LocalSystem from the drop down list. Save the configuration (Figure 14). 
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Figure No.14   

Note: These settings need to be done only on the Web Services and Web Server machine in case of multi-machine 

installation. In case of one machine installation, it has to be done on the server where SAS Marketing Operations 

Management is installed. 

 

Ensure that the Web Service Extensions section for the default web site allows ASP.NET for version v2.0.50727. Go 

to the Internet Information Service (IIS) Manager, click on the <Server Name> item in the Connections menu on 

the left pane. In the IIS section double click on the “ISAPI and CGI Restrictions” icon (Figure 15). 
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Figure No.15   

Allowed should be set for ASP.NET v2.0.50727 for 64 bit (Figure 16). 

 

Figure No.16   

2.5. Start ASP.Net State Service 
Start the ASP.Net State Service if it is not already started and ensure that this service has startup type as 

automatic. 
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3. SAS Marketing Operations Management Software 
Installation 

Installation on an individual server in the target configuration may require selection of multiple or one of the 

installer components depending on the tiers to be hosted on that server. Make sure to restart the machine after 

installation. 

Note: All the machines in the set up should be on the same network. 

3.1. Single Machine Installation  
The SAS Marketing Operations Management application can be installed on a single server but for EPS processing a 

separate server with Windows 7 is required if the user wants to use Artwork producer with Illustrator CS3/CS4 

module. This installation process described here assumes that a separate machine with Windows 7 with Adobe 

CS3/CS4 Illustrator installed is available in the hardware setup. 

3.1.1. Install All the Components 
Assuming that the IP address for all the solutions is 198.113.120.220 and for the Media Processor for Illustrator on 

a Windows 7 machine is 198.113.120.185. 

Supply following inputs for the installer: 
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Select Solutions, Web Services, Cataloger, Media Streaming, Media Processor for Indesign, Media Processor for FLV 

Generator, Media Server, Media Generator, Microsoft Office Processor and BusinessEvents Server components in 

the SAS Marketing Operations Management 6.0 R14 setup dialog. 

Note: Media Processor for FLV generator should preferably be on an independent machine if there is a constant 

usage of video files as it uses up considerable amount of memory and could choke up all the other requests. 

Specify the installation path by clicking on the ‘Browse’ button and selecting the Destination Folder. 

Click on the ‘Next’ button. 

 

Figure No.17   

Enter the password for ‘AlUser’ (Figure 18). 
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Figure No.18   

 

Figure No.19   

Please refer to the Installation guide for load balanced setup. Click on the ‘Next’ button (Figure 19).  
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Figure No.20   

Select whether this setup supports WebDAV (Figure 20). If yes then Figure 21 is displayed enter the WebDAV 

path (<Installation folder>\WebDavDir) details which can be any folder that the user creates on the NTFS machine 

where the WebDAV files can be kept (not necessarily the Installation directory) and click on the ‘Next’ button. If 

WebDAV is not supported then Figure 22 is displayed 

 

Figure No.21   
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Enter the IP Address on the network for the Windows 7 machine for the Media Processor for Illustrator and click on 

the ‘Next’ button. 

Note: If Media Processor is not being used in an installation then give the IP address of the machine on which the 

installation is being done. 

 

Figure No.22   

Select the protocol and click on the ‘Next’ button. 

 

Figure No.23   
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Enter the IP address (IP of the machine that you are installing SAS Marketing Operations Management on) for the 

server receiving the requests for the internet and click on the ‘Next’ button. 

 

Figure No.24   

As it is a single machine installation, only the Primary cataloger needs to be installed.  Select and click on the 

‘Next’ button.  

 

Figure No.25   
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The IP for the secondary cataloger is required to be left blank as on a single machine installation there cannot be 

two catalogers. Click on the ‘Next’ button. 

 

Figure No.26   

 

Review the inputs supplied in the Start Copying Files dialog and click on the ‘Next’ button. 

 

Figure No.27   
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Confirm Installation of Windows Services 
Right click on each of the service and start the service. The installer will set the service to automatic 

and set the selected services to run under the ‘AlUser’ account. 

Note: If any of the Services are not installed, launch the InstallServices.bat file located under <Installation 

Path>\Binaries. 

The settings for the IIS on the Web Services machine are done by the installer. In case they are not 

done see Section 8.4. 

Confirm successful installation of all the following services by launching the Services applet from the Administrative 

Tools control panel: 

Services Exe file 

User 
Account 
(Refer to 
section 

8.5) 

Component Description 

SAS MOM Back 
Office Service 

ALBackOfficeService.exe Local System Web Services This service manages all the back

office tasks for all the tenants, it 

stamps delay reminders for 

Projects and tasks and stamps 

messages to execute stored 

procedures for Ad-hoc reports and 

dashboards 

SAS MOM 
Dashboard 
Service 

ALDashboardService.exe Local System Web Services This service is used to generate 

data required for the channels 

created/configured in SAS 

Marketing Operations 

Management and visible on the 

Dashboard pages. 

SAS MOM 
Notification 
Service 

ALNotificationService.exe Local System Web Services This service is responsible for 

sending out notifications from SAS 

Marketing Operations 

Management system. 

SAS MOM Text 
Cataloger 
Service 

ALTextCatalogerService.exe Local System Web Services This service is used to extract 

words from the cataloged 

documents (For e.g.: PDFs, DOC, 

etc.) and add them in the 

database to enable search content 

within documents in SAS 

Marketing Operations 

Management. 

SAS MOM 
Queue Manager 
Service 

ALQueueManagerService.exe AlUser For all 

components 

except Media 

This service is responsible for 

fetching the messages from the 
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Streaming and 

Business 

Events Server 

Queues and invoking appropriate 

handlers for each type of Queue. 

SAS MOM 
Cataloger 
Service 

ALCatalogerService.exe AlUser Cataloger This service polls the database to 

check for the new catalog jobs 

and creates assets and also 

manages the creation of preview, 

thumbnails for the asset and also 

associate the metadata with the 

assets. 

SAS MOM File 
Watcher Service 

ALFileWatcherService.exe AlUser Cataloger This service polls the Cataloger 

Mount Point for the tenants to 

check for new jobs and updates 

the information related to the job 

into the database. 

SAS MOM 
Format Watcher 
Service 

ALFormatWatcherService.exe Local System Solutions This service is used to poll the 

Format Watcher Mount Point for 

creating InDesign formats in the 

system. 

SAS MOM 
WebDav Service 

ALWebDAVService.exe Local System Solutions This service is required if WebDAV 

is installed. This service keeps 

polling on the WebDAV location 

for the creation of “folderinfo.txt” 

file and it also updates the 

database with the location of the 

FDF file in which the reviewer 

comments are present. 

SAS MOM 
PluginService 
Service 

ALPluginService.exe AlUser Web Services, 

Media Server 

This service is used to invoke the 

Consolidation process for Acrobat 

files. It is also used to merge 

multiple PDF files into a single 

PDF file for approval in case of 

Components used in Workbench. 

SAS MOM 
BusinessEvents 
Service 

ALBusinessEventsService.exe AlUser BusinessEvent

s Server 

This service identifies and 

processes the change for an entity 

or facet record and logs the 

change in the database. 

SAS MOM 
Report 
Scheduler 

ALReportScheduler.exe Local System Web Services This service polls the database to 

check for the scheduled reports 

(Analytical / Ad hoc) and 

generates the report in PDF or 
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Excel format and stamps a 

notification for the receivers of the 

report. 

SAS MOM 
Service Monitor 

ALServiceMonitor.exe AlUser All the 

Machines 

This service monitors other SAS 

Marketing Operations 

Management services installed on 

the server. It is responsible for 

restarting the SAS Marketing 

Operations Management services 

if found stopped. 

SAS MOM NTFS 
Monitoring 
Service 

ALNTFSMonitoringService.ex
e 

Local System Web Services This service monitors the specified 

NFTS Folder and will add Events 

in MSMQ on NTFS change event. 

This service functions across all 

tenants. Currently this is not being 

used by any of the modules in 

SAS Marketing Operations 

Management. 

 

Note: The ‘SAS MOM Service Monitor’, monitors all the SAS Marketing Operations Management services on all the 

machines where SAS Marketing Operations Management is installed. If any of the services stop for some reason, 

this service will restart it. The interval of the polling can be adjusted in the xml. For more information on SAS MOM 

Service Monitor configuration refer to section 7.9. 

 

3.1.2. Install Media Processor for Illustrator on a Windows 7 machine 
Select the Media Processor component for Illustrator in the SAS Marketing Operations Management 6.0 R14 setup 

dialog. Specify the installation path by selecting the Destination Folder after clicking on the ‘Browse’ button. 



 

 
Page 34 

Installation Guide 
Version: 6.0 R14 

 

Figure No.28   

Enter the password for ‘AlUser’ (Figure 29). 

 

Figure No.29   
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In case Adobe Acrobat Illustrator CS3/CS4 software is not installed on the server (as mentioned in the software 

prerequisite) then the following dialog box will be prompted (Figure 30) where the version of Illustrator that will 

be used needs to be selected. 

 

Figure No.30   

Enter the IP Address of SAS Marketing Operations Management Web Services machine and click on the ‘Next’ 

button. 

 

Figure No.31   
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Review all the inputs supplied in the Start Copying Files dialog before clicking on the ‘Next’ button. 

 

Figure No.32   

Notes:  

1. The installer creates a virtual directory named ALServices with physical path <Installation 

Path>\ALServices. Please refer to Virtual Folder Configuration to ensure required settings for this 

directory. 

2. The installer creates a virtual directory named ‘ADCataloger’ on the cataloger machine with physical path 

<Installation Path>\ADCataloger.  

 

Confirm successful installation of services (Refer to section 3.1.1.1). 

 

Creating Queues Manually 
Queues are created when the installation is done. If for some reason queues are not created the queues can be 

created manually. Run the batch files Createqueues.bat file located under <Installation Path>\Binaries. 

The following queues are created on respective machines: 
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 SIMULTANE

OUSEVENT

Q 

        

 

3.2. Multi Machine Installation 
Note: All the components need to be installed on the same drive and the same network. 

 

Note: The above deployment is when you have two catalogers (Primary and Secondary). In case only 

one cataloger is being used then the ‘Primary Cataloger’ needs to be installed on the Cataloger 

Server. 

 

Assume the following configuration: 

Solutions Server + BusinessEvents Server + Primary Cataloger (if there are 2 catalogers) IP is: 198.113.120.1  

Notes:  

If the setup has SAS Marketing Operations Management Internal/External Solution Server deployment then SAS 

Marketing Operations Management replication agent needs to be installed and configured to synchronize data 

across two web solution servers, to configure a replication agent refer toSection 7.3.  

SAS Marketing Operations Management uses Media Server component to share the load of the IIS for downloading 

data from the system. So while downloading files, Media Server gets directly accessed by solution.  

In case of a DMZ set up, if the media server is installed on the internal server then the Solution cannot access the 

Media server directly. To handle this situation a Media Server Proxy configuration needs to done, refer to Section 

7.1. 

Web Services + Microsoft Office Processor + BusinessEvents Server IP is: 198.113.120.2 

Cataloger (Secondary Cataloger if there are 2 catalogers) + Media Server + Media Streaming + Media Generator + 

Media Processor for FLV Generator IP is: 198.113.120.3 

Note: If the installation is in DMZ, where Media Streaming server is configured on the internal network, files don’t 

 Cataloger Server 
(Secondary) 

 Media Server 
 Media Streaming 
 Media Generator 
 Media Processor for FLV  

Generator 

 Web Services (Application 
Tier)  

 Microsoft Office Processor 
 BusinessEvents Server 

Media Processor for 
Illustrator 

Media Processor for 
InDesign  

Suggested Deployment scenario 

 Solutions (Web Server 
Tier) 

 BusinessEvents Server 
 Cataloger (Primary) 
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get streamed if accessed from an external system. To handle this situation, Media streaming server needs to be 

configured on the external setup refer to Section 7.2. 

Media Processor for InDesign Server: 198.113.120.4 

Media Processor for Illustrator Server IP is: 198.113.120.5 

3.2.1. Install Solutions + BusinessEvents Server + Primary Cataloger on Web Server tier 
Select Solutions component in the SAS Marketing Operations Management 6.0 R14 setup dialog box. 

Specify the installation path by clicking on the ‘Browse’ button and select the Destination Folder. 

 

Figure No.33   

Enter the password for ‘AlUser’ (Figure 34). 
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Figure No.34   

Please refer to the Installation guide for load balanced setup. Click on the ‘Next’ button (Figure 35). 

 

Figure No.35   

Select whether this setup supports WebDAV (Figure 36). If yes then Figure 37 is displayed, enter the WebDAV 

path (<Installation directory>\WebDavDir) details and click on the ‘Next’ button. If WebDAV is not supported then 

Figure 38 is displayed. 
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Figure No.36   

 

Figure No.37   

Provide the IP address of the server hosting the web services. 
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Figure No.38   

Select the communication protocol to be used for accessing SAS Marketing Operations Management. 

 

Figure No.39    

Provide the IP address of the server receiving requests from the internet. This is the IP of the Solutions machine. 
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Figure No.40   

Provide the IP address of the Media server machine. 

 

Figure No.41   

Select whether this is a ‘Primary Cataloger Machine’. If yes then Figure 42 is displayed where the IP for the 

secondary cataloger needs to be entered. 
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Figure No.42   

Enter the IP Address of the Server hosting the Secondary Cataloger (optional). 

 

Figure No.43   

Enter the IP of the Illustrator Media Processor machine. 
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Figure No.44   

Enter the IP of the Media Generator machine. 

 

Figure No.45   

Enter the IP of the FLV Generator machine. 
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Figure No.46   

 

Review all the inputs supplied in the Start Copying Files dialog before clicking the ‘Next’ button. 

 

Figure No.47   
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Confirm successful installation of SAS Marketing Operations Management services (Refer to section 3.1.1.1). 

 

In case if Internal / External solution deployment: 

On External solution execute following batch files from the <Installation Directory>\Binaries folder: 

1. InstallDAMJobCopyServices.bat 

2. InstallReplicationAgentServices.bat 

On Internal solutions execute the following batch files: 

1. InstallReplicationAgentServices.bat 

 

3.2.2. Install Web Services+ Microsoft Office Processor + BusinessEvents Server 
Select Web Services, Microsoft Office Processor and BusinessEvents Server components in the SAS Marketing 

Operations Management 6.0 R14 setup dialog. 

Specify the installation path by clicking on the ‘Browse’ button and selecting the Destination Folder. 

Click on the ‘Next’ button. 

 

Figure No.48   

Enter the password for ‘AlUser’ (Figure 49). 
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Figure No.49   

 

Figure No.50   

Please refer to the Installation guide for load balanced setup. Click on the ‘Next’ button (Figure 50).  

Enter the IP address for the Web services and the Media Processor machine for Illustrator, InDesign and the FLV 

Generator (Figure 51). 
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Note: If Media Processor is not being used in an installation then give the IP address of the machine on which the 

installation is being done. 

 

Figure No.51   

Enter the Media Generator machine IP and click on the ‘Next’ button.  

 

Figure No.52   
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Select the communication protocol to be used for accessing the SAS Marketing Operations Management using the 

Internet browser. 

 

Figure No.53   

Provide the IP address of the server receiving requests from the internet. This is the IP of the Solutions machine. 

  

Figure No.54   

DNS Name or IP Address of the Server hosting the Media server. 
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Figure No.55   

DNS Name or IP Address of the Server hosting the Primary Cataloger and the Secondary Cataloger (optional). 

 

Figure No.56   

Review all the inputs supplied in the Start Copying Files dialog before clicking on the ‘Next’ button. 
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Figure No.57   

Note: The installer creates a virtual directory named ALServices with physical path <Installation Path>\ALServices. 

Please refer to Virtual Folder Configuration to ensure required settings for this directory. 

 

Confirm successful installation of SAS Marketing Operations Management services (Refer to section 3.1.1.1). 

 

3.2.3. Install Cataloger + Media Streaming + Media Server + Media Generator 
Select the Cataloger, Media  Streaming, Media Server and Media Generator components in the SAS Marketing 

Operations Management 6.0 R14 setup dialog box. 

Specify the installation path by clicking on the ‘Browse’ button and selecting the Destination Folder. 
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Figure No.58   

Enter the password for ‘AlUser’ (Figure 59). 

 

Figure No.59   
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Figure No.60   

Please refer to the Installation guide for load balanced setup. Click on the ‘Next’ button (Figure 60).  

Provide the IP Address of the machine where the Web Services have been installed (Figure 61). 

 

Figure No.61   

Provide the IP address of the server receiving requests from the internet. This is the IP of the Solutions machine. 



 

 
Page 55 

Installation Guide 
Version: 6.0 R14 

  

Figure No.62   

Select whether this is this machine hosts the Primary Cataloger (Figure 63) and click on the ‘Next’ button. 

 

Figure No.63   

Enter the IP address for Media Processor for Illustrator. If all the servers are in the same network then check ‘Can 

Illustrator Media Processor access Cataloger through the UNC path’ checkbox. If the servers are on a different 

network then it does not need to be checked but the HTTP port needs to be opened. Click on the ‘Next’ button. 
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Figure No.64   

Enter the IP address for Microsoft Office Processor which is on the Web Services machine. If all the servers are in 

the same network then check ‘Can Illustrator Media Processor access Cataloger through the UNC path’ checkbox. If 

the servers are on a different network then it does not need to be checked but the HTTP port needs to be opened. 

Click on the ‘Next’ button. 

 

Figure No.65   
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Enter the IP address for FLV Generator configuration for Cataloger, this is the machine on which the FLV generator 

is installed. If all the servers are in the same network then check ‘Can FLVGenerator Processor access Cataloger 

through the UNC path’ checkbox. If the servers are on a different network then it does not need to be checked but 

the HTTP port needs to be opened. Click on the ‘Next’ button. 

 

Figure No.66   

Review all the inputs supplied in the Start Copying Files dialog box before clicking on the ‘Next’ button. 

 



 

 
Page 58 

Installation Guide 
Version: 6.0 R14 

Figure No.67   

For configuring a Publishing Point for Media streaming see Section 4.2. 

Note: The installer creates a virtual directory named ‘ADCataloger’ on the cataloger machine with physical path 

<Installation Path>\ADCataloger.  

 

Setting display properties for thumbnail generation for PDF 
If the user catalogs PDF’s, the Cataloger generates a thumbnail for the PDF file. To generate the thumbnail 

properly, set the “display properties” on the cataloger machine as “True Color 32 bit”. 

 

3.2.4. Install Media Processor for Illustrator on Windows 7 machine 
Refer to the Section 3.1.2. 

 

3.2.5. Install Media Processor for InDesign 
Note: Media Processor for InDesign and FLV Generator should preferably be installed on separate machines and 

not with any other components as it clogs the other requests. Media Processor for FLV generator can be installed 

on an independent machine without the Media processor for InDesign. 

Select the Media Processor for InDesign and FLV Generator components in the SAS Marketing Operations 

Management 6.0 R14 setup dialog. 

Specify the installation path by clicking on the ‘Browse’ button and selecting the Destination Folder. 
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Figure No.68   

Enter the password for ‘AlUser’ (Figure 69). 

 

Figure No.69   
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Enter the IP Address of SAS Marketing Operations Management Web Services machine and click on the ‘Next’ 

button. 

 

Figure No.70   

Review all the inputs supplied in the Start Copying Files dialog before clicking on the ‘Next’ button. 

 

Figure No.71   

Create Queues manually refer to Section 3.1.2.1. 
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Confirm successful installation of SAS Marketing Operations Management services (Refer to section 3.1.1.1). 

 

3.3. Next steps after Installation 
On the machines where the Queue Manager Service  is installed :  

Open Queue Manager Config.xml  from path <Install Folder>\Configuration\XML and replace the values in the 

nodes FIRSTNAME, LASTNAME & EMAILADDRESS in the RECIPIENTLIST nodes with System Administrator's 

details. 

Note: This needs to be done before starting the Queue manager service. 

 

3.3.1. Settings to be done on the Microsoft Office Processor machine  
The user ‘ALUser’ gets created by the installer. These steps need to be executed after the creation of the user. 

Both the following settings need to be done on the Microsoft Office Processor machine.  

For MS Word: 

To launch the MS Word application on the Web services machine log in as ‘ALUser’ and follow the steps below: 

Launch the MS Word application. The user initials need to be entered (Figure 72) then click on the ‘OK’.  

 

Figure No.72   
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When the MS Word application is launched the following dialog box is launched (Figure 73). Click on the ‘OK’ 

button.  

 

Figure No.73   

The above setting is done so that the Word consolidation works for the Approvals job and task.  

 

For Acrobat 8.0/9.0/X: 

Launch the Acrobat 8.0/9.0/X Professional. When the Acrobat application is launched the following dialog box is 

launched (Figure 70). Check the ‘Do not show at startup’ checkbox and close the popup.  
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Figure No.74   

Logout as ‘ALUser’ from this machine. 

 

3.3.2. Settings to be done on the Illustrator machine  
After the Illustrator installation is completed do the following: 

Log in as ‘ALUser’ and launch the Illustrator application. 

When the Illustrator application is launched the following dialog box is displayed (Figure 75). Click on the ‘No, 

Thank You’ button and close the popup. 
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Figure No.75   

 

3.3.3. Security Permissions for Application Launch (DCOM Configuration) 
Launch DCOMCnfg from start | run. Navigate to the path Component Services | Computers | My Computer | DCOM 

Config. 

Follow the steps listed below for the applications mentioned in the tables for different tiers: 

Right click on the application and select ‘Properties’ from the speed menu. The settings need to be changed in 

the ‘Security’ and the ‘Identity’ tabs.  

In the Security tab the following settings need to be done: 
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Launch and Activation Permissions – If the user selects the ‘Customize’ radio button then click on the ‘Edit’ 

button. Add the users in the Group or user names box. Allow Local Launch, Remote Launch, Local Activation and 

Remote Activation permissions. 

Access Permissions – If the ‘Customize’ option is selected then click on the ‘Edit’ button. Add the users in the 

Group or user names box. Allow Local access and Remote access permissions. 

Configuration Permissions - If the user selects the ‘Customize’ radio button then click on the ‘Edit’ button. 

Add the users in the Group or user names box. Allow ‘Full Control’ to the user. 

 

Figure No.76   

Note: When DAM supports Shared Network folder then the DCOM settings for ALUser need to be done on the 

Application Services, Media Services and the Cataloger tiers. 

DCOM Setting for MS Office Processor Server 
User: Network 
Service, ALUser 
(IIS 7.0) 

Applications 

Permissions 
Microsoft 
Excel 
Application 

Microsoft 
Word 97 – 
2003 
Document 

Microsoft 
PowerPoint 
Slide 

AcroExch.AVD
oc  

AcroExch. 
PDBookmark 

Launch and 
Activation  Customize Customize Customize Customize Customize 

Access  Use Default Use Default Use Default Customize Customize 
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Configuration  Customize Customize Customize Customize Customize 

 

DCOM Setting for Web Server Tier (In case of WebDAV) 
User: Network Service, ALUser 
IIS 7.0) Applications 

Permissions AcroExch.PDBookmark AcroExch.AVDoc  

Launch and Activation  Customize Customize 

Access  Customize Customize 

Configuration  Customize Customize 

 

DCOM Setting for Media Processor for Illustrator CS3/CS4 (Windows 7 Machine) 

User: ALUser Applications 

Permissions ‘Illustrator Labcolor’ for CS3 and ‘Illustrator EPS’ for CS4 

Launch and Activation  Customize 

Access  Use Default 

Configuration  Customize 

 

The following additional setting needs to be done in the Identity tab for all applications mentioned in the DCOM 

Configuration: 

Select the ‘This User’ radio button. Click on the ‘Browse’ button to select the ‘ALUser’. Add the user to the 

Group or user names box. Provide the appropriate password for Password and Confirm Password field. Click on the 

‘Apply’ button to apply the configuration and then click on the ‘Ok’ button to save and close the configuration. 

 

Figure No.77   

Note: If the Queue Manager Service fails to launch the Illustrator Application then the DCOM configuration 

settings for Illustrator need to be changed. 
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Go to Computer Management > System tools > Local Users and Groups 

Add the ‘ALUser’ to Administrators group 

Go to the DCOM Config settings: 

Right click on the item and select ‘Properties’ from the speed menu 

Click on the ‘Identity’ tab 

Select ‘The Launching User’ option 

Click on the ‘Apply’ and ‘OK’ buttons to save the settings 

  

Figure No.78   

3.3.4. Settings for DAM supporting Shared Network Folder  
The following steps need to done for setting up the configuration: 

1. Create a shared drive folder on any machine on the same network as the installation machines. 

2. ‘ALUser’ should have complete access on the shared drive folder. 

Note: Please specify access for ‘ALUser’ on both ‘Security permission’ and ‘Sharing permission’. 

3. Allow ‘Full Control’ to ‘ALUser’ using the steps given in section 4.1 on the following locations: 

a. Installation folder. 

b. Windows Temp folder. 

c. “Temporary ASP.NET Files” folder .Net framework (Figure 79). 

d. C:\Temp (Temp folder set in environment variable) 

e. Network folder created. 

 

Figure No.79    

Note: If the installation is in the DMZ i.e. solution is installed on the external machine, then following key needs to 

be added in the <tenant>\web.config (on the external machine) - <add key="CURRENTNETWORK" 
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value="EXTERNAL" />. Adding this key, will take care of not showing “Network folder usage” specific 

functionality on the external machine as this machine cannot access network folder. 
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4. Pre-Tenant Configuration 

4.1. Configure a Publishing Point for Media Streaming 
Download and then run the MSU file for the Streaming Media Services role from the Microsoft Web site. 

The following steps are to be followed while creating a Publishing Point which is created for each tenant: 

1. Make sure to install ‘Streaming Media Services’. If not, install the component by following the steps given 

below: 

a. Go to Start and right click on ‘Computer’, select ‘Manage’ from the menu.   

 

Figure No.80   

b. On the ‘Server Manager’ screen select ‘Roles’ on the left pane and click on the ‘Add Roles’ link on 

the right. On the ‘Add Roles wizard’ popup click on the ‘Next’ button. 
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Figure No.81   

c. Install the ‘Streaming Media Services’ by following the instructions. 

 

2. After the ‘Window Media Service’ is installed, now the publishing point can be configured. Launch the 

Windows Media Services (reachable via Start | All Programs | Administrative tools| Windows Media 

Services).  

3. Right click on the ‘Publishing Points’ and select ‘Add Publishing Point (Advanced)’ (Figure 82). An ‘Add 

Publishing Point’ popup is launched (Figure 83). 
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Figure No.82   

In the ‘Add Publishing Point’ popup (Figure 83) select the Publishing point type as ‘On-Demand’, enter the 

Publishing Point name and select the location of the content by clicking on the ‘Browse’ button. A Windows Media 

browse is opened, click on the ‘Select Directory’ button. 

Note: This path should correspond to the Mount Point path mentioned in the Settings for Media Streaming (Refer 

to Administration guide – The settings section). 
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Figure No.83   

Click on the ‘Ok’ button on the ‘Add Publishing Point’ popup. 

4.2. Create Database user in SQL Server 
Follow the steps described below to create an account in SQL Server 2008 R2: 

1. Launch SQL Server Management Studio from Start | Programs | Microsoft SQL Server 2008 R2. 

2. Expand the Security folder on the left pane. 

3. Right click on Logins and select ‘New Login’. 

4. In the ‘Login-New’ popup (Figure 84) enter the login name. 

5. Select ‘SQL Server authentication’ radio button and enter the password for this login. 

6. Uncheck Enforce password expiration checkbox. 

7. Select ‘Master’ as the Default database and save the user. 
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Figure No.84   

8. Select ‘User Mapping’ from the left pane (Figure 85). 

9. Select the ‘msdb’ database and select ‘db_owner’ and ‘SQLAgentOperatorRole’ role membership to the 

new login. 
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Figure No.85   
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5. Tenant Configuration 

5.1. Create Tenant 
Note: The installation folder (created on all the machines in the setup) must have write access. Remove the read 

only setting for this folder.  

Create tenant by double clicking on the TenantCreation application located under the folder 

<Installation Folder>\Tenant Creation. 

The following screenshot shows typical inputs supplied for the tenant creation utility.  

 

Figure No.86   

Notes: 

 The tenant name should not have a dot or space. 

 Select the database type as SQL Server. 

 Enter Database Machine name/IP. 

 The database server instance is populated as soon as the database type is selected. It should not be 

changed unless required. For SQL Server it is ‘Default’. 

 Enter the database name for creating the database (tenant creation utility takes care of creating the 

database). The Database User Name and Password are the credentials of the SQL login created in 

section 4.3. 

 The ODS Database Name will be <Database name>_ODS by default. This should not be changed by the 

user. 

 The Server Installation Path refers to the installation path selected at installation. 

 The setting for Auditing is set to ‘True’ by default. 

 On the Web Server machine the Mount point (for Files) and XML Mount Point have to be located in a 

folder other than the tenant folder i.e. it can reside within the Installation Directory but not under the 
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tenant folder. E.g. Mount Point can be in a folder called Catalog Folder under D:/SAS MOM 60 but if there 

is a tenant called ‘MOM’ then the mount point should not be under this as there is a performance issue 

associated with this. Each tenant should have individual mount points and XML mount points. 

 The virtual directory ‘DashboardImages’ points to the outbox folder of the tenant. But on a single 

machine installation and there are more than one tenant and each has a different Outbox location (on the 

Web Server machine), then the virtual directory cannot point to all. This is an issue with the Dashboard. 

In case, the installation is done in this manner, please move all the outbox locations to one and also make 

the changes to the path of outbox in the <TenantName>.xml.  

Note: The Outbox path specified for the Tenant during Tenant creation should be such that the same 

drive should be present on Media Server Machine. 

 In case of a multi machine setup the ‘DashboardImages’ points to the ‘DashboardImages’ folder on 

the Solutions machine. 

 While creating a tenant if there are any errors then the error details can be viewed in a log file created in 

the path <Installation Folder>\CreateTenant_<TenantName>.txt. This log file is created only on the 

solutions machine, in case of multi machine setup the log file will be created on the web services 

machine. 

5.1.1. Folder Permissions 
After the tenant creation, give permissions for the following folders (if these folders are not in the installation 

folder) using the instructions given in section 8.3.3: 

1. MountPoint 

2. XMLMountPoint 

3. OutBox 

5.2. Create Cataloger Mount Point 
Type the following URL in the Internet browser to view the Login screen for the tenant 

http://<IP Address>/<Tenant Name>. 

Provide the username and password (admin, sa respectively). 

Navigate to the Tenant Settings page via the Settings link on the left pane under Administration. Provide the input 

for Mount Point field in the Cataloger Settings section for the Primary and the secondary cataloger (optional). The 

expected input for this field is the path in the file system under which the batch cataloger jobs will be submitted. 

(The Mount point should be outside the Installation folder) 

Note: This folder is created if it does not exist. The File Watcher Service polls this folder to detect arrival of batch 

cataloging jobs.  
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Figure No.87   

The following additional settings need to be done:  

1. If the Cataloger Mount Point folder is outside the installation directory then: 

The IUSR_<Machine Name>, NETWORK SERVICE and SYSTEM user accounts need to be given full control on the 

<Cataloger Mount Point> folder. 

2. The Cataloger mount point should be made a shared folder and ‘ALUser’ should have complete access on 

the cataloger mount point. 

Note: Please specify access for ‘ALUser’ on both ‘Security permission’ and ‘Sharing permission’. 

 

If the Cataloger and the Media Server are on different machines then the Cataloger Mount Point will be a shared 

folder then: 

1. Both Cataloger and Media server machine should have ALUSer configured with the same password e.g 

‘sa’. 

2. Create a shared folder on the cataloger machine. 

3. Shared folder should have complete access for the following users in both ‘Sharing Permissions’ and 

‘Security Permissions’ tabs:  

a. ALUser 

b. IUSR_<Machine Name> 

c. NETWORK SERVICE 

d. SYSTEM 

4. In the tenant settings the Cataloger Mount Point path should be specified as UNC path e.g. \\<Machine 

name>\<Shared Folder Name>\Cataloger Mount point 

5. On the Media server machine, ALMediaServices – Web.config should have the following tag under 

System.web: <identity userName ="ALUser" password ="<PWD>" impersonate ="true"/> 

6. Run the File Watcher and Cataloger Services under ALUser account. 

Note: Ideally the Cataloger and Media Server should be installed on the same machine. 
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6. Post Tenant creation 

6.1. Configure FTP Sites for Artwork Producer 
FTP Site Name Folder Path Description 

ExportedFormats or  

<TenantName>_ExportedFormats 

<Installation 

Dir>\<TenantName>\Exported 

Formats 

Formats exported from the 

system will be copied in this 

folder. The user can use this 

FTP site to download the 

exported format. 

DownloadedFormats or  

<TenantName>_DownloadedFor

mats 

<Installation 
Dir>\<TenantName>\Downloa
ded Formats 

Formats downloaded from the 

system will be copied in this 

folder. The user can use this 

FTP site to download the format. 

<Any Name> <Installation 
Dir>\<TenantName>\Import 
Formats 

System will use this folder to 

pick up formats to be exported 

into the system. The user can 

upload exported formats (to be 

imported into the system) to the 

folder using this FTP site. 

 

After creating the above FTP Sites the System Admin needs to modify the “<TenantName>.xml” from the 

location “<InstallationDir>\Configuration\XML” on the Solutions machine.  

After opening “<TenantName>.XML”, do the following changes:  

1. Go to “CONFIGURATION\ARTWORKPRODUCER\EXPORTFORMAT\FTPNAME” node and modify 

the FTP Name as given while creation of the ExportedFormats.  

2. Go to “CONFIGURATION\ARTWORKPRODUCER\DOWNLOADFORMAT\FTPNAME” node and 

modify the FTP Name as given while creation of the DownloadedFormats.  

 

6.2. Settings for Distributed Transaction Coordinator 
This setting is done for ODS feature. These settings must be done in a multi machine environment, when the 

Database and the Application Server are on different machines.  
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Note: These settings must be done on the Solutions machine, Applications Server and the Database server.. 

 

Following are the steps required to be followed. 

1. Traverse to Control Panel –> Administrative Tools –> Component Services 

2. Double Click on ‘Computers’ –> My Computer –> Distributed Transaction Coordinator  

3. Right Click on ‘Local DTC’ and select Properties. 

4. Select the ‘Security’ Tab. 

5. Enable the settings as shown in the image below. 

6. Click on Apply/OK. 

 

Figure No.88   

Note: After the settings are done, the machine needs to be restarted. 

6.3. Start Pre-Requisite Windows Services 
Start the Distributed Transaction Coordinator service if it is not already started and ensure that this service has 

startup type as automatic. 
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Figure No.89   

Start the following Windows services and set them as automatic: 

 SAS MOM Back Office Service. 

 SAS MOM BusinessEvents Service 

 SAS MOM Cataloger Service 

 SAS MOM DAM Job Copy Service 

 SAS MOM Dashboard Service 

 SAS MOM File Watcher Service 

 SAS MOM Format Watcher  

 SAS MOM Notification Service 

 SAS MOM PluginService Service 

 SAS MOM Queue Manager Service 

 SAS MOM Replication Agent Service 

 SAS MOM Report Scheduler 

 SAS MOM Service Monitor 

 SAS MOM Text Cataloger Service 

 SAS MOM WebDAV Service (Only if WebDAV is installed) 

 SAS MOM NTFS Monitoring Service 

6.4. Configure Schedule Tasks 
Note: Verify the Schedule tasks. 

Follow the following steps to schedule the utility. 

1. Go to Start Menu -> Programs -> Accessories -> System Tools -> Task Scheduler. 

2. Right click on ‘Task Scheduler (Local)’ and select ‘Create Task’. 

3. On the Create Task popup in the ‘General’ tab enter and name for the task and select the option ‘Run 

whether user is logged on or not’. 
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Figure No.90   

4. On the ‘Triggers’ tab schedule the task by setting the time the task needs to run. 
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Figure No.91   

5. On the ‘Actions’ tab browse and select the .exe file located in the <Installation folder>\Binaries. 
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Figure No.92   

6. The default settings need to be used in the ‘Settings’ and the ‘History’ tab. 

 

The utility is now scheduled and will automatically run every day at 12 AM. 

The following utilities are scheduled using the above process: 

6.4.1. Configure and Schedule SAS Marketing Operations Management Cleanup Utility 
This task needs to run on all the machines in the setup. 

ALCleanup utility is used to clean the temporary folders and files used by the SAS Marketing Operations 

Management system periodically. A copy of this utility is present on all the machines in the installation except the 

Media Processor. It needs to be scheduled to run on each of the machines. 

It works on a configuration XML which specifies which folder and the files to be deleted and which folders to 

exclude while cleanup. 
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Configure the ALCleanup settings XML 
 

 

Figure No.93   

This configuration xml is present along with the Tenant XML in the path <Installation 

Folder>/Configuration/XML/ALCleanup.xml 

The TempFolder node specifies which folders contents need to be deleted. The attribute Location of 

TempFolder specifies the path of the folder. E.g. C:\Temp is the folder whose contents will be deleted. 

The DeleteOlderThan attribute specifies the how old files one wishes to delete. The value 2 specifies that files 

older than 2 days needs to be deleted. 

The FileExtList specifies the type of files one wants to delete. You can specify the extension list separated by 

semicolon (;) if you wish to delete only specific type of files. If you want to delete all the files please specify .  

You can specify multiple folders to be deleted by using TempFolder node multiple times. 

 

Figure No.94   

You can also specify the folders inside C:\Temp you do not wish to delete. This can be done by adding 

AVOIDFOLDERLIST inside the TempFolder node. 

 

Figure No.95   

The above configuration specifies not to delete the FileConverter  folder inside C:\<Installation 

Folder>\Temp and its contents. Multiple AVOIDFOLDER nodes can be added to specify multiple folders, which 

should not be deleted. 
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The following folders need to be cleaned on the respective machines: 

Solutions 

Server  

Sr. Folder Name and Path:

1 <InstallationDir>\<Tenant name>\DownloadFiles 

(Used as a cache hence should not be cleaned up very frequently. After 10-12 days 

would be fine) 

2 <InstallationDir>\Temp (This cleanup is done by the installer) 

Note: The folder to be avoided for deletion is Windows Service Status. 

3 <InstallationDir>\<tenantname>\UploadedFiles 

 

Web Services/ 

Cataloger 

Machine 

Sr. Folder Name and Path:

1 C:\Temp (This cleanup is done by the installer) 

2 Outbox folder specified in tenant creation process.

Note: This is valid only for the Services Machine and not the Cataloger machine. 

3 <InstallationDir>\Temp (This cleanup is done by the installer) 

Note: The folder to be avoided for deletion is FileConverter. 

4 <InstallationDir>\Media Processor

Note: All files and folders under this directory should be deleted. 

 

FYI: Potential areas for cleanup are also: Downloaded Formats, Imported Formats and Exported Formats if the 

Artwork Producer module is being used.  This is just for the sake of maintenance information. Check for the 

correctness of the cleanup.xml by opening it in a browser to make sure the path mentioned for cleanup is correct. 

6.4.2. Schedule Task for DAM 
Schedule ‘AL_DAMBackGroundRequestHandler.exe’ to run at a time when there is less or no activity on the 

server. This exe is located in the ‘<installation Directory>/binaries’ folder. It has to be added as a scheduled 

task on the Web services machine.   

This task should be scheduled to run at a time when there are hardly any users logged into the system. It needs to 

be run at a time when the system is not due for restart. This operation takes a while to execute so there should be 

sufficient time between start of the task and the restart of the system. 

For the above task the following three operations can be performed: 

1. Recycle Bin cleanup - To empty recycle bin of content which are marked for permanent deletion. 

2. For marking the assets as expired - To mark assets which are having expired date less than the 

current date.  

Note: This task should be scheduled to be run after 12.00 a.m. This operation takes a while to execute. 

3. To calculate the total disk space usage by the Vaults - To calculate the total space used by the 

Vaults in DAM. 
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Notes: To change the application behavior certain parameters need to be set in the 

‘AL_DAMBackGroundRequestHandler.exe.config’ file. The changes are mentioned below: 

SENDEMAILFORVAULTDISKSPACE : true/false  

If the vaults total used disk space percentage is greater than the configured number then notification specifying 

vaults disk space details will be sent to System Administrator and the configured user(s) depending on the vaule 

specified for this configuration. By default the vaule is “true”. 

NOTIFYIFUSEDDISKSPACEPERCENTAGEGREATERTHAN  

Number specifying the percentage allowed for total used disk space. By default the vaule is 80. 

EMAILIDSFORVAULTDISKSPACENOTIFICATION  

Comma seperated email id’s of user who should get notified. 

 

 

6.4.3. Schedule ‘Security Policy’ report generation for DAM 
To generate data for Security Policy report, ‘SecurityPolicyService.exe’ application needs to be scheduled to 

run periodically. The default interval is three hours. Create a schedule task for this application. This exe is located 

in the ‘<installation Directory>/binaries’ folder. It has to be added as a scheduled task on the Web services 

machine.   

6.4.4. Schedule a ‘DAM Vault User Access’ report generation 
This report is used to get information related to user’s access to vaults in the system. It’s an off line report which is 

used to populate temporary table in the database, which will be used by the report to display data. To generate 

data for a DAM Vault User Access report, ‘DAMVaultUserAccess.exe’ application needs to be scheduled to run 

periodically. The default interval is three hours. Create a schedule task for this application. This exe is located in 

the ‘<installation Directory>/binaries’ folder. It has to be added as a scheduled task on the Web services 

machine.   
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7. Additional Configurations 

7.1. Media Server Proxy Configuration 
SAS Marketing Operations Management uses media server component to share the load of the IIS for downloading 

data from the system. So while downloading files, Media Server gets directly accessed by the Solution.  

In case of a DMZ set up, if the media server gets installed on an internal server then the solution can not access 

the Media server directly. To handle this situation a workaround is given as follows: 

While installing solutions in DMZ, select Media Server along with the other components. This Media Server will be 

treated as a proxy of the internal Media server. 

The following configuration needs to be changed after the installation. 

Tenant Web.config from the External solution machine 

         -  <add key=”DeploymentMode” value=”MULTI” /> 

         -  <add key=”ALMEDIASERVERFILEDOWNLOADURL” value=”http://<External solution 

machineIP>/ALMediaServices/Aspx/FileDownload.aspx” /> 

Media services web.config from External solution machine  

      Add following keys 

         -  <add key=”ALMEDIASERVERMTOMWS” value=”http://<Media 

ServerIP>/ALMediaServices/ALMTOMWS.asmx”/> 

         -  <add key=”ISMEDIASERVERPROXYINSTALLED” value=”true”/> 

         -  <add key=”UploadAssemblyName” value=”<Installation Dir>\SAS MOM\<Tenant 

Folder>\Bin\ALCommonExtension.dll” /> 

Dashboard service exe configuration from the internal server 

         InstallationMode = MULTI 

  

After doing these changes, the external solution will be able to download the Original and Preview files from the 

system as well as display the Digital asset channels on the external server. 

7.2. Media streaming server configuration in case of External (DMZ) setup 
If the installation is in DMZ, where Media Streaming server is configured on the internal network, the files don’t get 

streamed if accessed from an external system. 

To handle this situation, Media streaming server needs to be configured on the external setup. Make sure the 

entire configuration remains same as the configuration done on internal set up.  

Access the tenant settings screen from the external network and specify the values for the “Virtual Directory 

Name”, “Mount Point Path”, “Publishing Point” which are similar to internal set up.  

To configure Replication Agent for External Media Streaming server, refer to the section below. 

Note: Make sure the Streaming Server IP is of “External Media Streaming server”. 

7.3. Replication Agent Configuration 
Following are the guidelines for installing ‘Replication Agent’, which is used to replicate files across machines. 

Before starting the agent the following configuration need to be done: 
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7.3.1. Replication Agent Configuration details 
Replication Agent will always get installed on the Solutions (Web Server) machine.  

Replication Configuration XML is present in <Installation Dir>\Configuration\ReplicationAgentConfig.xml. 

 

Figure No.96   

Manual Steps: 

1. Replace $AL$INSTALLDIR$AL$ with Installation Directory Path E.g. Replace $AL$INSTALLDIR$AL$ with 

D:\SASMOM60_R14. 

Note: Do not replace with “D:\SAS MOM 60_R14\” it has to be “D:\SAS MOM 60_R14” 

2. Replace $AL$TENANTNAME$AL$ with the created Tenant. E.g. Replace $AL$TENANTNAME$AL$ with 

AEO. 

3. FILESTOPRESERVE: This has to be configured only in case where certain attributes from the file to be 

retained after replication. E.g. In case of AEO, Internal machine, setting for WEBDAVREQUIRED is always 

set to “YES” and in case of External machine setting for WEBDAVREQUIRED is always set it to “NO”. 

 

If Enable Media Streaming is configured for a given tenant, then uncomment the clause from 

“ReplicationAgentConfiguration.xml” from both internal and external machine. 

On the external machine set the <External Machine IP> to the IP address of External Media Streaming server.  

On the Internal machine set the <External Machine IP> to the IP address of Internal Media Streaming server.  

 

<CLAUSE> 

<XPATH>CONFIGURATION/MEDIASTREAMING/MEDIASTREAMING_SERVER_IP</XPATH> 

<VALUE><External Machine IP></VALUE> 

</CLAUSE> 
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Note: If there is no need of retaining certain attributes, please remove ‘FILESTOPRESERVE’ node. 

Following is the list of folders and files, which the Replication Agent Service monitors for replicating: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Replication doesn’t take responsibility of replicating sites across machines. So sites created in the system 

through internal or external set up have to be manually replicated on the other machines. That means sites 

created on the internal setup have to be manually copied on the external machine. This holds true for External to 

Internal also. Whenever any changes are made to respective sites should follow this process. 

7.3.2. Replication Server Details 
Replication Server will always get installed on the SAS Marketing Operations Management Services machine. 

 

On that machine, configure the “ReplicationServerConfig.xml” from the <Installation Dir>\Configuration\XML. 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\DAM\Configuration\XML *.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\DAM\Configuration\XML\FormBuilder *.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MediaLibrary\Configuration\XML *.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MediaLibrary\Configuration\XML 

\FormBuilder 
*.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\StrategicPlanner\Configuration\XML *.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\StrategicPlanner\Configuration\XML 

\FormBuilder 
*.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MarketingWorkbench\Configuration\XML SolutionConfigura

tion.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MarketingWorkbench\Configuration\XML *_DataTransferC

onfig.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MarketingWorkbench\Configuration\XML 

\FormBuilder 
*.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\Approvals\Configuration\XML\ *.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\Approvals\Configuration\XML\FormBuilde

r 
*.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\Administration\Configuration\XML *.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\Administration\Configuration\XML\FormB

uilder 
*.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\ResourceManagement\Configuration\XM

L 
*.xml 

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\ResourceManagement\Configuration\XM

L\FormBuilder 
*.xml 



 

 
Page 91 

Installation Guide 
Version: 6.0 R14 

The above configuration needs to change, to indicate which all agents are present and the details about that 

agent. After the configuration the XML will look like: 

<CONFIGURATION> 

<AGENTLIST> 

<INTERNALAGENT> 

<AGENT IP=“198.113.120.127“ >c:\SAS MOM 60</AGENT> 

</INTERNALAGENT> 

<EXTERNALAGENT> 

<AGENT IP=“198.113.120.172“>E:\SAS MOM 60</AGENT> 

</EXTERNALAGENT> 

</AGENTLIST> 

</CONFIGURATION> 

If the ‘CommunicationProtocol’ for INTERNALAGENT is always TCP and for EXTERNAL Agents 

‘CommunicationProtocol’ can be specified by default it is http://. 

7.3.3. MediaRequestRouter 
This setting is required only in case of External machine [not in network]. 

Open the file from “<Installation Dir>\Configuration\XML\MediaRequestRouter.xml”. The node specific to 

ReplicationServer in MEDIAPROCESSQ needs to change pointing to the internal machine ReplicationServerQ. 

Change the highlighted portion to “FormatName:DIRECT=http://<Internal machine IP 

address>/msmq/Private$/ReplicationServerQ”. 

 

After the changes the XML should look like: 

<MEDIAPROCESSOR SOLUTIONNAME=”ReplicationManager”> 

<ROUTEMESSAGETIMEOUT>720</ROUTEMESSAGETIMEOUT> 

<APPLICATION TYPE=”ReplicationServer”> 

<MEDIAPROCESSORQPATH>FormatName:DIRECT=http://198.113.120.127/msmq/Private$/ReplicationSe

rverQ</MEDIAPROCESSORQPATH> 

<FILEPATH> 

<REPLACEABLEPATH>D:\SAS MOM\Replication</REPLACEABLEPATH> 

<NETWORKPATH/> 
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</FILEPATH> 

</APPLICATION> 

<APPLICATION TYPE=”ReplicationAgent”> 

<MEDIAPROCESSORQPATH>FormatName:DIRECT=TCP:198.113.120.172\Private$\ReplicationAgentQ</M

EDIAPROCESSORQPATH> 

<FILEPATH> 

<REPLACEABLEPATH>D:\SAS MOM\Replication</REPLACEABLEPATH> 

<NETWORKPATH/> 

</FILEPATH> 

</APPLICATION> 

</MEDIAPROCESSOR> 

7.3.4. InstallReplicationAgentServices.bat 
After the configuration, the services can be started. For installing the Replication Agent on the installation, Run the 

“InstallReplicationAgentServices.bat” from the <Installation Directory>\Binaries. This will install the service and 

make it visible in to the Services Panel. 

 

Replication needs SAS MOM Queue Manager Service to be running also. Start both the services from Service Panel. 

7.3.5. UninstallReplicationAgentServices.bat 
For uninstalling the replication service run the “UninstallReplicationAgentServices.bat” from <Installation 

Dir>\Binaries. This will remove SAS MOM Replication Agent Service from Service Panel.  

7.4. Fine Tuning Tips 

7.4.1. Running Services Selectively  
When the SAS Marketing Operations Management software is installed there are several Windows services 

installed. These services run in the background to facilitate certain functionality provided by the different solutions. 

As these processes run in the background they consume resources in terms of database access and memory. 

Based on the solution usage these services can be selectively started:   

Sr. Name of Service Application which requires this service 
1 SAS MOM Back Office Service Marketing Workbench, Approvals, Timesheets, 

Campaign Manager, Strategic Planner 
2 SAS MOM BusinessEvents Service Strategic Planner (This can be for Marketing 

Workbench, Claims Management, Offer 

Management and  all other solutions where change 

management – Audit History on forms is tracked)  

3 SAS MOM Cataloger Service DAM (Mainly DAM, but could be used by other 

modules if cataloging is getting used. Such as 

Artwork Producer) 
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4 SAS MOM DAM Job Copy Service DAM

5 SAS MOM Dashboard Service Dashboard & Calendars

6 SAS MOM File Watcher Service DAM (Mainly DAM, but could be used by other 

modules if cataloging is getting used. Such as 

Artwork Producer) 

7 SAS MOM Format Watcher Artwork 

8 SAS MOM Notification Service All Modules

9 SAS MOM NTFS Monitoring Service Campaign Manager

10 SAS MOM PluginService Service Marketing Workbench, Approvals, Strategic Planner

11 SAS MOM Queue Manager Service Marketing Workbench, Approvals, Ad hoc Reports, 

Timesheets, Strategic Planner, DAM 

12 SAS MOM Replication Agent Service All modules (used only in case of AEO type of 

deployment) 

13 SAS MOM Report Scheduler Ad hoc Reports, Standard Reports 

14 SAS MOM Service Monitor All modules (as this monitors all the services used 

by various modules) 

15 SAS MOM Text Cataloger Service DAM (Text Search)

16 SAS MOM WebDAV Service (Only if 

WebDAV is installed) 

Marketing Workbench, Approvals, Strategic Planner 

7.4.2. Improving the performance of the DAM Solution 
Following are the keys and its values that need to be added in “Web.config” file located under path “<Installation 

Dir>\<Tenant Name>\”, on the server where the solutions are installed. 

E.g.: 

<add key=”MULTIDOMAINSUPPORT” value=”true” />  

<add key=”MAXDOMAINCOUNT” value=”5” /> 

<add key=”PREFIXDOMAINNAME” value=”Sun” />  

<add key=”SUFFIXDOMAINNAME” value=”india.sas.com” />  

Multidomain support is done to improve the performance while fetching the thumbnails in DAM. Browser will 

serialize the request to download a particular file. If there are 100 Assets to be shown on the screen, then to 

download these many files requires more time as only 2 files can be downloaded at a time. If multiple domains are 

configured then these requests get divided into number of domains, increasing the performance.  

Note: Configure the domain before setting the multidomain key to “True”. 

 

7.4.3. Improving the performance of the SAS Marketing Operations Management Solution 

SQL Services 
For improving the performance of SAS Marketing Operations Management solution the following SQL Services need 

to be kept started/not started and kept automatic/manual/disabled: 

  SQL Services Started/Not Started Automatic/Manual/Disabled
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SQL Server (MSSQLSERVER) Started Automatic 
SQL Server Active Directory Helper Not Started Disabled 

SQL Server Agent (MSSQLSERVER) Started Automatic 

SQL Server Analysis Services 

(MSSQLSERVER) 

Not Started Manual 

SQL Server Browser Not Started Disabled 

SQL Server FullText Search 

(MSSQLSERVER) 
Started Automatic 

SQL Server Integration Services Not Started Manual 

SQL Server Reporting Services 

(MSSQLSERVER) 
Off Manual 

SQL Server VSS Writer Off Manual 

 

Cache Management 
1. Application Service Cache: Application Services caches the metadata such as Entity Type, Facet Type 

and Relationship Type as an in-memory cache. This reduces queries to the database. The cache is 

configurable and can be turned on using the key in Web.config of the ALServices virtual directory.  

<add key="OMCacheEnabled" value="true"/> - The value true represents the cache is enabled and false 

otherwise.  

Note: The cache is refreshed if the metadata is changed from the Schema Designer. If the metadata is 

modified apart from Schema Designer then a restart of the web server is required on the Application 

Server machine. 

  

2. Named Hierarchy Cache: SAS Marketing Operations Management solution caches the Named Hierarchy 

information as a persistent data on the file system. This improves the performance as data is fetched 

from the cache instead of the web service calls. The cache is stored at the following location: 

<Installation Directory> 

     | 

       ----- Temp 

                 | 

                  ----- <Tenant Name>_Cache 

 

All the named hierarchy is stored as XML.  

The cache is configurable and can be turned on using the key in the Web.config of <TenantName> virtual 

directory on the SAS Marketing Operations Management Solution machine. 

<add key="PersistentCacheEnabled" value="true"/> - The value true represents the cache is enabled and 

false otherwise. 

Notes:  

1. If possible keep this folder out of the cleanup process. 
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2. The cache is refreshed if the named hierarchy is changed from Schema Designer. If the named 

hierarchy is modified apart from Schema Designer then the XML file(s) have to be deleted from the 

persistent cache. 

7.5. IIS Performance Tuning 
SAS Marketing Operations Management is based on Microsoft .NET technology. It uses various Microsoft 

Technologies in its own solution. It is assumed that the SAS Marketing Operations Management product is being 

installed on Windows 2008 Server and IIS 7.0 as the base platform.  

For the smooth working of the product the configuration that is required on Internet Information Services (IIS) is 

as follows: 

7.5.1. Application Pool Settings 
Enable ASP.NET - ASP.NET is disabled by default in IIS 7.0. If the ASP.NET is not enabled then you may see the 

following error: 

  

Figure No.97   

Follow the steps below to enable ASP.NET: 

1. Open the Internet Information Services Manager. 

2. Traverse to “Web Services Extension” section. 

3. Select ASP.NET v2.0.50727 and click on ‘Allow’.  
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Figure No.98   

The following steps describe the configuration which is recommended for DefaultAppPool application pool. (If SAS 

Marketing Operations Management is configured on any other Application Pool then these are applied for the 

configured Application Pool): 

1. Recycling - The DefaultAppPool have the “Recycle Worker Process” setting enabled, which restarts the 

ASP.NET worker process after 1740 minutes i.e. 29 hours. It is recommended to disable the settings by 

following the steps below: 

2. Open the Internet Information Services Manager. 

3. Traverse to Application Pools | DefaultAppPool properties. 

4. Traverse to Recycle tab and uncheck the ‘Recycle Worker Process’. 

  

Figure No.99   
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5. Performance - The DefaultAppPool has the “Idle Timeout Shutdown Worker Process” setting enabled, 

which shuts down the ASP.NET worker process if the worker process is being idle for 20 minutes. It is 

recommended to follow the steps below: 

a. Open the Internet Information Services Manager. 

b. Traverse to Application Pools | DefaultAppPool properties. 

c. Traverse to Performance tab and uncheck the ‘Shutdown Worker Process after being idle 

for’. 

 

Figure No.100   

7.6. Configure SAS Marketing Operations Management for full Text search 
The default logical operator that is used for multiple words based simple search is ‘AND’. It has been kept 

configurable so that if it needs to be changed for deployment then the steps below need to be followed to change 

the logical operator to OR: 

Step 1: Open the <TenantName>.xml from the <Installed Directory>\Configuration\XML or \\<Machine 

Name>\Shared Drive\Configuration\XML in case of load balance setup. 

Step 2: Look for the following XML node 

<FULLTEXTSEARCH> 

<LOGICALOPERATOR>AND</LOGICALOPERATOR> 

</FULLTEXTSEARCH> 

Change the AND to OR (vice-versa). 
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<FULLTEXTSEARCH> 

<LOGICALOPERATOR>OR</LOGICALOPERATOR> 

</FULLTEXTSEARCH>  

7.7. Suppress Dialogs for Automatic Updates 
Perform the following steps to uncheck the automatic updates in Adobe Acrobat 8.0/9.0: 

1. Click on the Help > Check for Updates option. 

2. This checks for the Updates and then it displays the link for ‘Preferences’ on this screen. 

3. Click on the ‘Preferences’ link and the check box for ‘Automatically check for updates’ is displayed. 

4. Uncheck this and click on the ‘OK’ button. 

7.8. SAS Marketing Operations Management Service Monitor Configuration 
The SAS Marketing Operations Management services are installed on all the machines where the software is 

installed. Depending on which components are installed, the services will get installed. For some reason if a 

specific service should not be watched then its respective node should be removed from the list and the monitoring 

service should be restarted. The xml for the ‘SAS MOM Service Monitor’ service is found in the <Installation 

Directory>\Configuration\XML\ALServiceMonitorConfiguration.xml. The following screenshot specifies the services 

on the respective machines.  
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8. Troubleshooting 
Note: After the installation is completed check the log files for any exceptions. The log files 

(InstallationSettingsLog.txt and CreateTenant_MOM.txt) are stored in the ‘Installation folder’ 

of that machine.  

8.1. User creation fails - Configure Windows User on the Server 
Note: If ‘ALUser’ already exists on the machine then the password will get reset to what was accepted from the 

user while installing SAS Marketing Operations Management. 

‘ALUser’ (this user should be a member of the Administrators group) needs to be created on all the machines 

where SAS Marketing Operations Management is installed and on the machine on which the shared network folder 

is created (For supporting shared Network Folder). 

 

To create the ‘ALUser’ follow the steps below: 

Go to Start > Administrative Tools > Server Manager > Configuration > Local Users and Groups > Users. The 

following steps are required to create the new user: 
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1. Right click on the ‘Users’ link and select ‘New User’ from the speed menu 

2. Enter all the necessary values such as name (ALUser) and password 

3. Select ‘User cannot change password’ 

4. Select ‘Password never expires’ 

5. Click on the ‘Create’ button 

 

Figure No.101   

Note: Make sure that the user name and password is the same on all the machines in the configuration. 

8.2. Configure Environment Variables - Failed  
If the installer fails to configure the environment variables then follow the steps given below: 

8.2.1. For All Machines 
The same settings need to be done on all the machines involved in the setup. 
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Right click on the ‘Computer’ icon, click on Properties and then click on the ‘Advanced System Settings’ link. Select 

the ‘Advanced’ tab. Set the system environment variables TEMP and TMP to point to folder C:\Temp. Create the 

folder C:\Temp if it does not exist. Allow ‘Everyone’ and ‘ALUser’ full control on this folder.  

Note: The System Environment Variables can be edited from the advanced tab of the dialog box shown below. 

Right click on the My Computer icon and select Properties option. 

 

Figure No.102   



 

 
Page 103 

Installation Guide 
Version: 6.0 R14 

 

Figure No.103   

 

Figure No.104   

TEMP and TMP are present in User Environment Variables and are accessible from the dialog box described above. 

However these are to be left unchanged. 

8.3. Virtual Folder ‘aspnet_client’ creation failed 
Create a virtual folder named “aspnet_client”  and pointing to aspnet_client folder under www root.(e.g. 

C:\Inetpub\wwwroot\aspnet_client). 

8.4. Security Permissions 
If the installer fails to provide the security permissions do the following:  
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8.4.1. On ASP.NET temporary files 
The ‘<OS Dir>\Microsoft.NET\Framework\v2.0.50727\Temporary ASP.NET’ file needs to be given ‘Full Control’ to 

the ‘Users’ groups (Right-click and open up the Security tabs for this folder). 

8.4.2. Registry Access  
For ALUser: The setting needs to be done on all the machines on which SAS Marketing Operations Management 

is installed. 

Give registry access to the newly created user (ALUser) using the following steps: 

Open registry by “regedit” on run window. 

Traverse to the path “HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\Eventlog” 

Right click and click on the permissions, and add the newly created user (ALUser) and give full control. 

 

For NETWORK SERVICE users: The setting needs to be done on all the machines on which SAS Marketing 

Operations Management is installed. 

Give registry access to NETWORK SERVICE users using the following steps: 

Open registry by “regedit” on run window. 

Traverse to the path “HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\Eventlog” 

Right click and click on the permissions, and add the NETWORK SERVICE users and give full control. 

8.4.3. Grant Folder Permissions 
Allow the IUSR_<Machine Name>, NETWORK SERVICE and ALUser user accounts full control on the 

<Installation Path> folder on all the machines the installation has been done. Follow the steps below in Windows 

Explorer: 

1. Right click on the installation folder and select ‘Properties’. 

2. Select the ‘Security’ tab.  

3. Select the user and give ‘Full control’. 

For example if the server on which installation is being done is called Metis, the accounts IUSR_ Metis, NETWORK 

SERVICE user needs to be granted full control on <Installation Path> folder. 

Note: Give full control to ‘ALUser’ on all the machines where the ALUser is created. 
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Figure No.105   

8.5. Adding DLL in GAC 
In a multi machine installation both the dll’s (FluorineFx.ddl and itextsharp.dll) are not required for every 

component, but the installer tries to install both. As only the dll required on a particular machine will be available, 

the installer writes a fatal error to the log file if one of the dll is not found.  

Please note the scenario when we can ignore the error message: 

1. For FluorineFx.dll: It is required if the following components are installed on a machine: 

a. Cataloger  

b. Solutions 

 

Ignore the following Message in logs if any other component is installed: Severe Error. Installer is 

probably corrupt and Installation will be unusable. 

Unable to find DLL fluorinefx.dll at the following location: C:\SASMOM60_R14\..\SASMOMTools\fluorinefx.dll 

 

1. For itextsharp.dll:  It is required if the following components are installed on a machine: 

a. Cataloger  

b. WebServices  

c. MediaProcessor for Illustrator  

d. MediaProcessor for InDesign 

e. Solutions 

f. MediaServer 

g. MediaProcessor for FLV Generator 
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Ignore the following Message in logs if any other component is installed: Severe Error. Installer is 

probably corrupt and Installation will be unusable. 

Unable to find DLL itextsharp.dll at the following location: C:\SASMOM60_R14\..\SASMOMTools\itextsharp.dll 

Note: If it is a single machine installation then both the dll’s will be present. 

 

In case a DLL is actually required and not installed to GAC, follow the steps below to put the files into the 

assembly: 

1. If Microsoft Visual studio is installed on the machine. 

a) Install the DLL in GAC 

b) Type the following command in VS command prompt of visual studio 

Sn –Vr  <Dll Path> 

For example: Sn –Vr  C:\GACDemo\fluorinefx.dll 

Gacutil –i <Dll Path> 

For example: Gacutil –i C:\GACDemo\fluorinefx.dll 

 

2. If working on Windows 7 or Windows Server 2008 R2 (64 bit SP1) 

a) Directly drag and drop the DLL’s to the assembly folder (Path -> C:\Windows\assembly). 

 

8.6. Running a service under the ‘ALUser’ context 
Some selected services need to run under ‘ALUser’, if the installer fails to do this then the following needs to be 

done:  

Apply the following settings for SAS MOM Queue Manager, Cataloger, BusinessEvents , PluginService, File Watcher 

and Service Monitor services in the Services applet: 
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1. Go to the services panel by clicking on Start > Administrative Tools > Server Manager and then click on 

the Services item. 

2. Right click on the ‘<Service>’ and select properties from the speed menu. 

3. Click on the ‘Log On’ tab. 

4. Select the ‘This account’ option in the ‘Log on as’ section.  

5. Click on the ‘Browse’ button and select the ‘ALUser' account. 

  

Figure No.106   

6. Click on the ‘General’ tab. 

7. Select the startup type as ‘Automatic’. 

8. Click on the ‘Ok’ button to apply the settings. 

Note: On both the machines ‘ALUser’ needs to be given full control on the installation folder. 

8.7. Next Steps 
When the ‘SAS MOM Queue Manager Service’ windows service is started on any machine, it creates ‘SAS 

MOM’ event log in the event viewer, a property of this event log needs to be set, so that the event log will never 

be full.  

After starting all the services on all machines, a setting needs to be changed in the Event Viewer. Follow the steps 

below: 

1. Go to Start > Administrative Tools > Server Manager>Diagnostics and click on Event Viewer. 

2. On the left pane, go to the SAS MOM Log and right click on it. Select the ‘Properties’ link. 
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3. Select the radio button saying ‘Overwrite events as needed’.  

Ignore if the SAS MOM Log is not present. 

 

Figure No.107   

8.8. Create Shared Drive  
A ‘MediaProcessor’ folder is created on the Web Services and Media Server Machines after installation of SAS 

Marketing Operations Management. It is created under the installation folder. 

On both the machines share the folder and add the ‘ALUser’ in the security and sharing tab and specify Full Control 

to the user. 

Note: Make sure the shared folder has the name ‘MediaProcessor’ on both the machines. The name should not be 

changed. 
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Figure No.108   

8.9. Database Setup – If database creation fails 
A separate database needs to be created for each tenant. 

8.9.1. Create Database for Tenant 
Create database to be used for the tenant using SQL Server Management Studio (reachable via Start | Programs | 

Microsoft SQL Server 2008 R2). Follow the steps described below:  

 Connect to the server by entering the database user credentials.  

 On the left pane right click on Databases and click on ‘New Database’. 

 In the ‘New Database’ popup (Figure 108) type the new database name and click on the ‘OK’ button. 

The new database is now created. 
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Figure No.109   
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8.9.2. Run the Database scripts 
Run the database scripts against the tenant database by connecting to the SQL Server by using the new login 

created above. The database scripts are under the installation folder>Database>SQL Server (Figure 110). 

 

Figure No.110   

Select the database created in the above sections and click on File>Open>File and select the scripts from the 

installation folder>Database>SQL Server. Click on the ‘Open’ button. Click on the ‘Execute’ button and connect to 

the SQL Server using the login created for the database. 

Note: Keep checking the database name to make sure the scripts are run on the selected database. 

The database scripts are to be run in the following sequence: 

1. 1_MOM_SQL_Scripts.sql 

2. 2_MOM_Init_SQL_Scripts.sql 

3. 3_MOM_SchemaUpdates_SQL_Scripts.sql 

4. 4_MOM_UpdateInserts_SQL_Scripts.sql 

5. 5_MOM_Indexes_SQL_Script.sql 

6. 1_MOM_DB_INSERT_SCHEMA_SCRIPT.sql 

7. 2_MOM_DB_Get_QuarterOfDate_Function.sql 

8. 3_MOM_DB_STORED_PROC_SCRIPT.sql 
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Figure No.111   

8.10. Create ODS Database for Tenant 
Following the steps in the above section another Database needs to be created. The convention that needs to be 

followed for name of the ODS Database is <DB Name for the Tenant>_ODS. The following scripts need to be 

executed for the ODS database: 

1. 1_ODS_DB_CREATE_SCRIPT.sql 

2. 2_ODS_DB_INSERT_SCRIPT.sql 

3. 3_ODS_DB_STORED_PROC_SCRIPT.sql 

8.11. WebDAV Configuration for PDF Approvals 

8.11.1. Creating a WebDAV folder 
A WebDAV folder needs to be created on the Web server machine and the path should correspond to the path 

given while installation with the WebDAV setup. 

8.11.2. Creating a Virtual Directory for the WebDAV folder 
Create a virtual directory with name ‘ALDocShare’ and refer to the WebDAV folder path accepted above. See 

Section 8.11.1 for creating the Virtual directory. Give READ, WRITE and DIRECTORY BROWSING access to the 

ALDocShare virtual directory. 

Note: This virtual directory has to be created on the Solutions machine. 
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8.11.3. Change the Web service extension in the IIS on Solutions machine 

  

 

Figure No.112   

In the IIS Manager on the solutions machine, click on the <Machine Name>. double click on the ‘ISAPI and CGI 

Restrictions’ icon. Right click on the WebDAV item and select the ‘Allow’ option, by default it is prohibited. 

8.12. Configure a Virtual Folder for the Tenant 
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Create a virtual folder named <Tenant Name> and pointing to <Installation Folder>\<Tenant Name> folder as its 

physical path. The Virtual Folder can be configured as follows: 

8.12.1. Virtual Folder Configuration 
Go to the IIS Manager (reachable via Start>Administrative Tools>Internet Information Services (IIS) Manager. To 

create virtual directories follow the steps below: 

1. Right click on the ‘Default Web Site’ and select ‘Add Application’. Add a new Application by entering the 

‘Alias’ which is the tenant name and enter the path as the ‘Installation folder\tenant name’. Click on ‘OK’ 

to save. 

 

Figure No.113   

Follow these steps for virtual directory configured for each Tenant: 
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1. Ensure that in the ‘Default Document’, default.aspx document is present and is at the top. 

2. Double click on the ‘HTTP Response Headers’ icon. The ‘HTTP Response Headers’ screen is displayed. 

Right click and select ‘Set Common Headers’. Select ‘Expire Web content’ and ‘After’ enter the number 

of days.  

Note: In case of ‘HTTPS’ setup for an installation, the web content expiration has to be set to 1 or more 

days in the IIS for the tenants.  

 

Figure No.114      

3. To configure new MIME Types double click on the ‘MIME Types’ icon. Right click and select ‘Add’. In the 

popup add the following new MIME Types having Extension as: 

  
Associated Extension Content Type (MIME) 
.axd webresource

.css text/css  

.gif image/gif 

.js application/x-javascript

.xpdl text/plain 

.flv video/x-flv

.swz application/x-swz



 

 
Page 116 

Installation Guide 
Version: 6.0 R14 

.air application/vnd.adobe.air-

application-installer-package+zip 

  

 

Figure No.115   

Note: It is recommended to clear the browser cache after any new installation.  

8.13.  Creating Virtual Folder for Dashboard 
Create a virtual directory with name ‘DashboardImages’, see Section 8.11.1 for creating the Virtual directory. 

Give READ access to the virtual directory. The Virtual directory should be created on the Solutions machine (Web 

Server). 

This has to be created on the Web Server machine where SAS Marketing Operations Management solutions are 

installed. On a single machine setup the DashboardImages virtual directory should point to the ‘Outbox’. On a 

multi machine setup, ‘OutBox’ is created on Service Machine. So on the Solutions Machine, manually create a 

DashboardImages folder and point this to the virtual directory of DashboardImages.  

8.14. Creating the Desktop folder 
Create a ‘Desktop’ folder (if not created) under following location:  

 <WindowsInstallationDir>\System32\config\systemprofile\  
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8.15. IIS Manager - Changing the application Pools setting 
Go to IIS Manager via Start/Administrative Tools>Server Manager. Expand <Machine Name> and click on 

Application Pools. Double click on ‘DefaultAppPool’. Check if the ‘Manage pipeline mode’ is set to Classic if not set 

it.  

 

Figure No.116   

8.16. Complete access for ‘ALUser’ 
Verify that ‘ALUser’ has complete access on all private MSMQ's. Go to Programs and right click on ‘Computer’. 

Expand ‘Features’ and ‘Messaging Queues’ and then ‘Private Queues’. For all the SAS Marketing Operations 

Management queues verify that the ‘ALUser’ has complete access by right clicking on each of the queues and 

going to the ‘Security’ tab. 
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Figure No.117    

Note: Verify that all request to web server machine run under ALUser account i.e. The web.config file present in 

"<InstallationDir>\<Tenant>" folder has following Identity tag: <identity impersonate="true" userName="ALUser" 

password="<PWD>" /> 

  

 




